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Apa yang Perlu Diketahui

	Acrobat DC: Pergi ke Tools > Combine Files > Add Files > Combine.
	Pratonton Apple: Buka PDF dan pilih Lihat Imej Kecil. Pilih lokasi sisipan. Pilih Edit > Insert > Halaman daripada Fail.
	PDF Merge: Pergi ke tapak web PDF Merge, pilih Choose File, pilih PDF dan pilih Open. Ulang untuk PDF kedua. Pilih Gabung.


Artikel ini menerangkan cara menggabungkan fail PDF ke dalam satu dokumen menggunakan Acrobat DC, Mac Preview dan tapak web PDF Merge. Maklumat tambahan disediakan untuk menggabungkan PDF pada peranti mudah alih dan menggunakan Gabungkan PDF dan Gabungkan PDF.



Cara Menggabungkan Fail PDF Dengan Adobe Acrobat DC

Adobe Acrobat Reader adalah percuma. Anda boleh menggunakan Acrobat Reader untuk melihat dan mencetak fail PDF, serta menambah anotasi. Untuk memanipulasi lagi fail ini atau menggabungkan berbilang PDF menjadi satu, pasang Acrobat DC.

Ikuti langkah ini untuk menggabungkan fail PDF dengan Adobe Acrobat DC:

	
Buka Acrobat DC dan pilih Tools > Combine Files.




Image


	
Pilih Tambah Fail untuk menambah seberapa banyak fail yang anda mahu. Pilih Tambah Fail Terbuka untuk memasukkan dokumen yang sedang anda lihat.




Image


	Laraskan susunan, termasuk halaman individu, dengan menyeret dan menjatuhkan setiap satu ke lokasi yang dikehendaki.
	
Pilih Gabungkan untuk melengkapkan proses.
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Acrobat DC tersedia untuk yuran langganan bulanan atau tahunan yang berbeza-beza berdasarkan versi aplikasi dan tempoh komitmen. Jika anda mempunyai keperluan jangka pendek, Adobe menawarkan percubaan percuma selama 7 hari, yang tidak mengandungi pengehadan dari segi kefungsian.



Cara Menggabungkan Fail PDF Dengan Pratonton Apple

Pada Mac, gunakan aplikasi Pratonton terbina dalam untuk menggabungkan fail PDF, menghapuskan keperluan (dan kos, kerana Pratonton adalah percuma dengan macOS) untuk perisian pihak ketiga atau perkhidmatan dalam talian.

	Buka salah satu fail PDF yang ingin anda gabungkan dalam apl Pratonton.
	
Pergi ke menu Lihat dan pilih Lakaran kenit, jika ia tidak dipilih, untuk mendayakan pratonton lakaran kecil.

Untuk menogol paparan Imej Kecil, tekan Option+ Arahan+ 2 pada papan kekunci.
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Jika PDF yang terbuka mempunyai lebih daripada satu halaman, pilih lakaran kecil dalam panel kiri tempat anda ingin memasukkan fail PDF lain.

Halaman PDF yang disisipkan muncul selepas halaman yang dipilih.
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Pilih Edit > Insert > Halaman daripada Fail.
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	Dalam tetingkap Finder, cari fail PDF kedua yang anda ingin import ke dalam fail semasa, kemudian pilih Open.
	Ulang langkah 4 dan 5 untuk setiap fail PDF tambahan yang ingin anda import.
	Seret lakaran kenit untuk menukar susunan halaman.
	Apabila anda berpuas hati dengan gabungan PDF, pilih Fail > Simpan.




Cara Menggabungkan Fail PDF Dengan Gabungan PDF

Beberapa tapak web menawarkan perkhidmatan penggabungan PDF. Banyak yang didorong iklan dan percuma. Salah satu daripadanya ialah PDF Merge, yang membolehkan anda memuat naik berbilang fail menggunakan pelayar web. Terdapat had 10 MB untuk fail yang dimuat naik.

PDF Merge juga menawarkan apl boleh dimuat turun dengan harga berpatutan yang menggabungkan PDF di luar talian. Hanya versi Windows yang tersedia.

	Pergi ke tapak web Gabungan PDF.
	
Pilih Pilih Fail.
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	Pilih PDF pertama yang ingin anda cantumkan, kemudian pilih Buka.
	
Pilih Pilih Fail sekali lagi untuk fail lain yang anda ingin gabungkan. Jika anda kehabisan slot, pilih More Files.
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Pilih Gabung untuk menggabungkan fail yang dipilih.

Fail digabungkan dalam susunan yang anda pilih dan muat naik setiap fail.
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	Muat turun gabungan PDF terakhir ke komputer anda.




Cara Menggabungkan Fail PDF Dengan Gabungkan PDF

Combine PDF ialah alat berasaskan web yang menggabungkan berbilang dokumen PDF ke dalam satu fail PDF. Gabungkan sehingga 20 fail, termasuk imej, ke dalam satu fail PDF secara percuma. Gabungkan tuntutan PDF untuk memadam semua fail daripada pelayan mereka dalam masa satu jam selepas muat naik.

	
Pergi ke tab Gabungkan PDF, jika ia tidak dipilih.
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Seret fail PDF ke halaman web Gabungan PDF. Atau, muat naik fail dalam cara tradisional dengan memilih Muat naik Fail.
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	Laraskan susunan fail yang dimuat naik dengan menyeret fail dalam baris gilir.
	
Pilih Gabungkan.
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	Fail PDF yang digabungkan, combinepdf.pdf, dimuat turun ke komputer anda.




Cara Menggabungkan Fail PDF Dari Awan Dengan Gabungan PDF

Merge PDF, sebahagian daripada tapak Smallpdf.com, ialah penyelesaian berasaskan penyemak imbas percuma yang menggabungkan fail daripada peranti tempatan anda, Dropbox dan Google Drive. Sebelum anda menggabungkan fail ke dalam satu fail PDF, gunakan Gabungkan PDF untuk menyeret dan melepaskan fail untuk menyusun semula atau memadam halaman sesuka hati anda.

Semua muat naik dan muat turun dianggap selamat, dan fail dipadamkan secara kekal daripada pelayan Smallpdf dalam masa sejam. Tapak ini juga menawarkan perkhidmatan berkaitan PDF yang lain, termasuk alat melihat dan mengedit serta keupayaan untuk menukar format fail.

	
Pilih sama ada Dari Google Drive atau Dari Dropbox untuk membuka tetingkap log masuk.
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	Masukkan bukti kelayakan log masuk anda untuk perkhidmatan awan untuk melihat fail berasaskan awan anda.
	Pilih fail yang ingin anda muat naik, kemudian pilih Pilih.




Cara Menggabungkan Fail PDF pada Peranti Mudah Alih

Terdapat apl Android dan iOS yang menggabungkan fail PDF pada telefon pintar atau tablet. Banyak apl mudah alih yang menjanjikan fungsi ini sama ada tidak memberikan hasil yang diharapkan atau dibangunkan dengan buruk, mengakibatkan ranap yang kerap dan tingkah laku lain yang tidak boleh dipercayai. Pilihan ini adalah yang paling boleh dipercayai:

	PDF Util: Apl yang sering dikemas kini ini menggabungkan sejumlah besar fail PDF daripada peranti Android dan mempunyai ciri berguna yang lain. Kefungsian asas tersedia tanpa bayaran, manakala pengalaman tanpa iklan boleh diperolehi dengan pembelian dalam apl.
	PDF Utility: Walaupun terdapat beberapa batasan dalam edisi percuma apl Android ini, termasuk saiz fail maksimum 2.5 MB, PDF Utility menggabungkan dua atau lebih dokumen PDF dengan cepat. Versi pro menarik balik sekatan ini dan mengalih keluar semua iklan.
	PDF Converter: Apl iOS ini menggabungkan fail PDF pada Apple iPhone atau iPad dengan agak mudah. Pembelian dalam apl mengalih keluar beberapa had saiz dan nombor fail.
	Pakar PDF: Salah satu apl iOS yang lebih dikenali dan stabil dalam senarai ini. Tanda harga Pakar PDF amat berbaloi jika anda menggabungkan fail PDF daripada pustaka iCloud anda dengan kerap.












Disyorkan:


Cara Mengubah PDF menjadi Dokumen Word




Perlukan kandungan PDF dalam dokumen a.DOC/DOCX? Tukar fail ke format Microsoft Word. Ketahui cara menukar PDF kepada Word menggunakan pelbagai kaedah

Cara Menggabungkan Dua atau Lebih Dokumen Microsoft Word



Temui tutorial langkah demi langkah yang akan menunjukkan kepada anda cara menggabungkan dua atau lebih dokumen Microsoft Word menjadi satu dokumen utama

Cara Menggabungkan Berbilang JPEG Menjadi Satu PDF



Anda boleh membuat berbilang JPEG menjadi satu PDF pada Windows atau Mac menggunakan alatan terbina dalam atau program dalam talian seperti penukar JPG ke PDF

Cara Menggabungkan Fail PDF pada Mac



Jika anda perlu menggabungkan berbilang fail PDF ke dalam satu fail, dan anda mempunyai Mac, ianya mudah! Berikut ialah cara untuk menggabungkan fail pdf pada Mac menggunakan Pratonton dan apl pihak ketiga

Cara Memuat Naik Dokumen Word ke Dokumen Google



Gunakan fail Microsoft Word pada Dokumen Google untuk melihat, mengedit dan berkongsinya secara percuma. Untuk menggunakan dokumen Word pada Dokumen Google, muat naiknya ke Google Drive
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Menyelesaikan Masalah Kamera Kodak - Betulkan Kamera Kodak Anda
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Kawal Amazon Echo Anda Dari Jauh Dengan Telefon Anda
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Adakah DoorDash Down Atau Adakah Anda?

2024





















Ulasan terbaik di bulan


	



Skrin Projektor Kelabu lwn Putih: Mana Yang Perlu Anda Gunakan?







	



Emas dalam Telefon Anda Boleh Membantu Planet







	



Cara Mendapatkan Prestasi Terbaik daripada Subwufer Anda







	



Cara Membakar Fail Imej ISO ke DVD







	



Cara Memilih Pemasangan Dinding TV







	



Cara Memasang dan Menyediakan Microsoft Teams untuk Mac







	



Cara Menggabungkan Dua atau Lebih Dokumen Microsoft Word







	



Cara Mendikte dalam Word







	



Cara Membuat Alexa Berkata Apa yang Anda Mahukan







	



Cara Muat Turun dan Main Fortnite pada PS4







	



Cara Membuat Teks Boleh Disunting dalam Paint.NET







	



Cara Melakukan Superskrip dalam Word







	



Cara Menggunakan Pemain MP3 dalam Kereta Anda







	



Cara Mematikan Mesej Diserlahkan dalam Apple Mail







	



9 Perisian Seni Digital Terbaik 2022
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Verizon Secara Rasmi Melancarkan Liputan Jalur Lebar Ultra 5G
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Buat kesan Vignette dalam tiga aplikasi pengimejan

2024







	









Cara Mengubah Saiz Imej pada Mac

2024






























Nasihat


	



Cara Membaiki Radio Kereta Yang Tidak Dimatikan

Apabila radio kereta anda tidak dimatikan apabila anda menjangkakannya, terdapat tiga perkara utama yang perlu dilihat







	



Semakan Pengurai PC

PC Decrapifier ialah penyahpasang perisian yang kecil, mudah alih, percuma yang membantu anda mengalih keluar perisian sarap dan program lain daripada sistem anda secara automatik







	



Apple Music Dilancarkan untuk Peranti Penstriman Roku

Apple Music baru sahaja tersedia pada peranti penstriman Roku, termasuk televisyen Roku, tongkat penstriman, pembesar suara dan banyak lagi







	



Cara Membuat Latar Belakang Imej Telus dalam PowerPoint

Anda boleh menjadikan latar belakang imej telus dalam PowerPoint menggunakan alat pengalih keluar latar belakang. Kemudian anda boleh melihat apa yang ada di sebalik imej itu. Ini caranya







	



Cara Pergi ke Mesej Seterusnya atau Sebelumnya dalam Gmail

Ketahui cara menggunakan bar alat mesej dan pintasan papan kekunci dalam Gmail untuk pergi ke e-mel seterusnya atau sebelumnya




















Pendapat pakar.


	



Aktifkan Lipatan Anda-Asus Melancarkan Tablet OLED Zenbook 17 Lipatan

Asus baru sahaja mendedahkan Zenbook 17 Fold OLED, tablet lipat 17 inci dengan spesifikasi yang mengagumkan







	



Galaxy Tab Active4 Pro Berjanji untuk Mengendalikan Apa sahaja yang Anda Hidangkan-Apa yang Perlu Tahu

Samsung telah mendedahkan Galaxy Tab Active4 Pro baharunya, dan ia kelihatan sangat kukuh







	



Anda Mungkin Akan Lebih Mudah Menyulap Apl Antara Peranti Android

Peranti Android anda menjalankan apl yang sama, namun menukar antara apl tersebut di tengah-tengah tugasan memerlukan sedikit kerja. Nasib baik, Google cuba mengubahnya







	



Ciri Paling Penting iOS 16 Mungkin Butang Carian Ini

IOS 16 sepatutnya mendapat butang untuk fungsi Carian, dan jika ia berlaku, itu boleh menjadikan segala-galanya pada iOS lebih mudah untuk dicari dan diakses







	



Pelayan DNS Percuma dan Awam Terbaik (September 2022)

Senarai pelayan DNS awam terbaik dan percuma sepenuhnya, serta cara menukarnya. Senarai pelayan DNS ini kali terakhir dikemas kini pada September 2022
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Buat dan Gunakan Templat E-mel dalam Outlook

Adakah anda mengarang mesej yang serupa berulang kali? Sediakan templat e-mel dalam Outlook dan tulis mesej baharu serta balas dengan lebih pantas Dikemas kini untuk memasukkan Outlook 2019







	



Jenis Lampiran Disokong untuk Dilihat dalam Gmail

Sesetengah lampiran Gmail boleh dipratonton dalam penyemak imbas anda tanpa memuat turunnya. Ketahui jenis lampiran yang disokong untuk dilihat dalam Gmail







	



Alat Gmail yang Menghilangkan Kerumitan E-mel

Gmail bagus, tetapi anda boleh menjadikannya lebih baik dengan menggunakan alatan pengurusan e-mel yang dibuat hanya untuk Gmail. Berikut adalah beberapa yang akan menjimatkan masa dan tenaga anda







	



Cara Mengimport Alamat Ke Gmail Daripada Perkhidmatan E-mel Lain

Dapatkan senarai kenalan e-mel ke akaun Gmail anda dengan mengeksportnya sebagai fail CSV ke dalam Gmail. Import buku alamat daripada Yahoo, Outlook.com dan banyak lagi







	



Cara Menag Seseorang di Instagram

Anda boleh menandakan nama seseorang pada siaran Instagram dengan mengetik Tandai Orang di bawah medan kapsyen. Anda juga boleh menandakan orang dalam cerita dan ulasan
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